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Chapter 1  

Introduction  

Efficient planning plays a pivotal role in the success of any project. Projects face 

various types of risk during the execution phase and timely response to these risks 

saves projects significant time and cost. 

Earned Value Management (EVM) is the technique that helps the project manager 

with planning, taking timely action against risks and improving the project 

performance. EVM is known as "management with the lights on" because it helps 

the project manager see the project's current and forecasted performance by 

looking at the project metrics, generated by EVM. Another essential feature of EVM 

is that it integrates the three pillars of project management: schedule, scope, and 

cost.  

Instead of having to use any external software for Earned Value Analysis (EVA), 

we can use Microsoft Project for EVM analysis. Microsoft Project uses all formulas 

related to EVM analysis so there is no need to memorize any formula for the 

computation of any EVM components. 

This guide will show you how to use Microsoft Project 2019 to prepare the 

construction schedule and EVM. Preparing a proper schedule helps in effective 

project monitoring and controlling. In the guide, we will create a construction 

schedule from scratch, which will be used later for the EVM report creation. This 

guide will help provide an understanding to those who not only wish to learn about 

scheduling, but also EVM. Follow the steps described in the various following 

sections to create a schedule and perform EVM analysis. 
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When we open a blank project in Microsoft Project, we can see the screen splits 

into two parts, as shown in figure 1. The sheet's left side shows the table 

columns/fields, whereas the sheet's right side shows the blank space for the Gantt 

Chart.  

 

Figure 1 Microsoft Project Screen  

The Microsoft Project professional settings are dependent on the project 

requirements, and we can tweak the project according to the project requirements. 

Before preparing this project schedule, we altered the Microsoft Project settings. 

Setting the Project under Options Menu 

Before creating the new project schedule, set Microsoft Project's options to meet 

project requirements, leaving those you do not wish to alter as the default value 

settings. Within this example, we made significant changes in the project Schedule 

tab of the Options dialogue box.  

The first thing to do is to set the project calendar. The project calendar must remain 

consistent for a project; otherwise, we will encounter problems with EVM. Let's 

start with general calendar settings.  

• To do this, we click the File tab button on the top left corner of the Microsoft 

Project screen. 

• After clicking on the File tab, open the Options tab located at the bottom left 

side, shown in the green box in figure 2.  
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Figure 2 Options Tab 

• Click on the Options button. 

• Herein, we can see the Project Option dialogue box.  

Calendar Option for the projects 

• Click on Schedule tab on the left before setting the general calendar settings for a 

particular project.   

• We made the same calendar settings for all of the projects, as shown in figure 3. 

• Thus, we select All New Projects. This way, all new projects have the same 

calendar settings.   
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Figure 3 Calendar options for All New Projects 

Default Day and Hour Settings 

• Now, Let's begin with the working days or hours.   

• This project assumes that work will start on Sunday and the fiscal year starts in 

January.  

• We set 9 hours per day as working hours. So, let's assume the work starts at 8:00 

and ends at 18:00. 

• The default start time matches our scenario, so no change is required here. In 

contrast, we adjusted the default end time to 18:00 because we are planning to 

work for 9 hours, starting at 08:00.  

• Accordingly, we adjusted the hours per day to 9 hours/day from the default 8 

hours/day.  

• Each day has 9 hours, and each week has six days. So, our total weekly working 

hours will be 54 hours.   

• Days per month depends upon the month. We entered our estimated value here. 

We assume that each month will be four weeks and update the working days per 

month equivalent to 24 days/month (6 days x 4 weeks).    
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Figure 4 Setting Days and Hours 

Schedule  

• I ticked the "Show scheduling messages” box as it will help determine any 

Microsoft Project schedule inconsistencies. 

• Below this, we have an option for our resources. We can either select the 

percentage or decimal option as shown in figure 5. For example, if any task 

requires three workers and a percentage option is selected, we need to assign 

300% of this resource to this task. And if the decimal option is selected, we enter 

3 instead of 300%.  

 

Figure 5 Schedule Message and Assignment Units 

Scheduling Option for this Project  

• Firstly, changed the "New task created" option from ‘Manually Schedule’ to ‘Auto 

Schedule’, for our schedule to become dynamic.  

• We added the duration in days and work in hours. Duration defines the time, in 

calendar days, required to complete the project work.  
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• We changed the default task type to ‘Fixed Units’.  

• We ticked the ‘New tasks are effort driven’ box as it was unticked.  

Default task type and new tasks are effort-driven because they affect the calculation 

of Microsoft Project.   

 

Figure 6 Scheduling options for this projects 

Setting the Project under Project Menu 

In the project setting, we adjust project settings according to the project 

requirements. These settings help with calculations. To change these settings, 

click on the Project tab located on the top ribbon, as shown in figure 7. 

 

Figure 7 Setting Project Calendar 

Change Working Time 

• We will select ‘Change Working Time’ which located inside the Properties group.  

• A new window will pop up, as shown in figure 8.  

• In this change working time dialogue box, we will set the setting to meet the specific 

requirements of our project. In this dialogue box, we will put working days in a 

week, public holidays, and vacations.  
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Figure 8 Change Working Time 

• First, we will set the Calendar specific to our project.  

• In the upper right corner, we will click ‘Create New Calendar’. Now, let's name the 

new calendar. For our example, we named it “Guide Calendar”.  

 

Figure 9 Create New Base Calendar 

• In the create new base calendar dialogue box, select the “Make a copy of standard 

calendar”. 

• This will allow us to start creating our calendar using the standard calendar.  

• Now, we hit the OK button to create our new calendar.  

• Above, we can see the name of our new calendar, Guide Calendar. Now, we can 

start inputting specific settings for our project.  

• Let us set the working days and hours.  

• To do so, click on the workweeks tab as shown in figure 10. 
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Figure 10 Setting Work Weeks 

• Then, click on the detail button shown on the right side of the work weeks table. 

• A new dialogue box for Details for ‘[Default]’ will open. 

 

Figure 11  Default Working Time in a Week 

In the figure above, we can see the default calendar settings. These show that 

from Monday to Friday the working hours will be from 8:00 to 12:00 and then 13:00 

to 17:00. Therefore, the total working hours will be 8 hours. Between Monday and 

Friday, we observe a working hours pattern however this differs for Saturday and 

Sunday. Saturday and Sunday represent non-working days because they have no 

working hours and are therefore days off.  
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In our example, we adjusted working hours from 8:00 to 18:00, including a 1-hour lunch 

break between 12:00 and 13:00, which is equivalent to 9 working hours per day. 

Secondly, we altered the weekend working-hours to state that we would work full time 

i.e., 9 hours, on Saturdays also. Sunday remains a day of no work. The steps below show 

how we made these changes. 

Note: values in the table should be the same as the values we entered in the schedule 

under the options menu. If the values are different, we will not get the correct calculations 

or will get undesired results.  

• To change the working hours per day, click on the required day(s) within the left 

hand-side table. 

• After selecting the days, check the "Set day(s) to these specific working times" 

option. Then we can edit daily working hours.  

 

Figure 12  Adjusted Working Time in a Week 

• We change the working times for Monday. We will start the work from 8:00 to 

12:00, followed by an hour break from 12:00 to 13:00. Then we will again perform 

the work from 13:00 to 18:00. Instead of changing the working hour for the rest of 

the days one by one, we select all the days from Monday to Saturday, check the 
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option of "Set day(s) to these specific working times," and change the working 

timings accordingly.  

• Let's click on the OK button below and exit this dialogue box.  

• Again, click the OK button below and exit the "change working time dialogue box." 

Now, we have completed our calendar settings.  

Assigning Calendar to Gantt Chart 

• When we looked at the Gantt chart, we found two vertical grey strips for Saturday 

and Sunday. These vertical grey strips represent non-working days. So, to set this 

vertical only for Sunday right click on the Gantt chart area, a dialogue box will pop 

up.  

• Select non-working time from the dialogue box.  

 

Figure 13 Assigning calendar to Gantt Chart 

• Select the non-working time tab from the pop-up window and change the calendar 

from standard to guide galendar (or whatever your personalised calendar has 

been named). 
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Figure 14: Changing Calendar for Gantt Chart 

• After clicking the OK button, we will return to the main screen. Now, we can see 

only one vertical grey strip which represents Sunday.   

• Sunday is represented by grey as it is a non-working day. 

 

Figure 15 After Changing the Calendar for Gantt Chart 

Assigning Calendar to Project   

• Now, let's assign the calendar to the project. To do so, select the project tab from 

the ribbon.  

• Select the "Project Information" button inside the Properties group.  

• In the calendar field, we are selecting our Calendar: "Guide Calendar" from the 

drop-down menu. Now, we have assigned the required calendar to our project. Hit 

the OK button and return to the main page.  
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Figure 16 Assigning Calendar to Project 

 

 

 

 

 

Chapter 2  

Creating Work Breakdown Structure  

We have set our project settings. Now, we will work on the project’s work breakdown 

structure (WBS). WBS helps to understand the project efficiently.  

• Considering the construction of single storey house as a project for this 

hypothetical project, we assumed a four-level WBS structure as shown below:  

o Foundation Work,  

o Construction Work,  

o Electrical and Plumbing Work, and  

o Backfilling and Landscape Work.  

Let's see how to create WBS of a new project in Microsoft Project.  

• To do this, we click on the first row of the Task name Column and start to write the 

elements of our WBS.  

• We start with Excavation Work; after entering the Excavation work, Duration, Start, 

and Finish values pop up automatically. 
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• Duration seems to be one day with a question mark at the end. The question mark 

shows that Microsoft Project has assumed duration by default. Since we are 

creating our WBS elements, we don't need to do anything with the question mark 

now. Therefore, we create other WBS items such as construction work and 

backfilling and landscape work. 

 

Figure 17 Creating WBS  

Setting up Activities  

After entering the four-level WBS items, we will add our activities. In this part, we will enter 

only the name of the activities.  

• Let's enter the first activity under the WBS heading of Foundation Works. To do 

this, right-click on the first row under the Foundation Work, and the drop-down list 

will pop up.  

• Select the Insert Task option from the drop-down menu.  

 

Figure 18 Insert Task under WBS 

• Change the activity name. To do this, click on the < New Task > under the Task 

Name column and rename it, we renamed ours Excavation Work. Press Enter after 

renaming the activity. The other way to add the task is to directly click the Task 

button shown in the Insert menu under the Task tab.  
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• As we can see, the WBS heading and task activity are on the same level. Since it 

is an activity under this group, it can not be on the same level. Instead, it should 

be at the next level, so we indent the activity.  

• To indent the activity, first, select the activity row you wish to be lowered a level 

before clicking on the indent task button shown under the Schedule group of the 

Task tab.  

 

Figure 19 Indent Activity under WBS 

• As we click on the indent task button, the WBS task will become bold, becoming a 

group rather than an activity. With excavation work becoming the first activity within 

this group. 

• We add wall construction, concreting of floor, plastering, door and window 

installation, painting and roofing works under the construction works group. 
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Figure 20 Inserting all the Activities under WBS 

Setting up Dependencies in among the Tasks 

We have successfully added the project activities in the last section. Now we will 

develop the relationships between the activities.  

• First, we need to expand the table to see more columns. Directly after the Finish 

column, we can see the predecessor column.  

 

Figure 21 Showing Predecessor and Resource Name Column 

• Linking the activities will depend upon the condition or type of the project. We can 

have the following types of relationships between the activities.  

o Finish to Start Relationship: Activity X will start when we finish the Activity 

Y.  
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o Start to Start Relationship: Activity X and Activity Y will start simultaneously 

with or without lag.  

o Finish to Finish Relationship: Activity X and Activity Y will finish 

simultaneously with or without lag.  

o Start to Finish Relationship: Activity X will complete when the Activity Y 

begins.  

• Now, we will develop the connection between the activities. We will select the 

activities that need to be linked. To select the two activities simultaneously, we will 

choose the first activity, and by using the Ctrl button, we choose the second 

activity. After selecting both activities, we will click on the Link button shown in 

Schedule properties under the Task menu.  

 

Figure 22 Linking the Activities 

• Pressing the Link button, we can see ‘2’ will appear in the predecessor column for 

the Laying of Lean activity. It means that the activities Start of Excavation Work 

and Laying of Lean are linked together with the FS relationship.   

• In the Gantt Chart, we can see a Finish to Start relationship between the activities 

Start of Excavation Work and Laying of Lean. It means that the Laying of Lean will 

start after the completion of Excavation Work. 

• We can also see that the start and finish dates of these activities are also changed. 

The first activity will start on 2nd February and end on 2nd February since the 

second activity will start on 3rd February and end on 3rd February.  
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Figure 23 Finish to Start Relationship between the Activities 

Double-clicking on any activity is another way of linking the activities.  

• When we double click on any activity, the Task Information box pop up.  

• In this Task Information dialogue box, we will click on the Predecessor tab. We can 

see the Task Name; moving our cursor to the first row, a small black triangle will 

appear. 

• Click on the small black triangle because it has all the project's activities. When we 

select the activity, Microsoft Project automatically fills the ID column.  

• Task name will be filled automatically. We can also change the type of relationship 

and the lag period between the activities.  
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Figure 24 Inserting activities through Dialogue box and Adding Lag between 

activities 

• By following the steps mentioned above, we will link all our activities. Again, the 

type of link between activities depends on the type of resources we have or the 

project/activity type.  

Entering the Working Hours 

In the previous section, we developed the relationship between the activities. Now, in 

this section, we discuss working hours for the respective activities. There is a 

difference between the Duration and Work. Duration is the time in calendar days 

required to complete the task. Work refers to the effort required to complete the job. 

For example, a task requires two laborers and three days (one day has nine hours) to 

complete the task. The task's duration is three days, whereas the task's effort requires 

54 working hours (3days*9hours*2people) or six workdays.  

• First, we add the work column right behind the predecessor column. To add the 

work column, we extend the table by dragging the vertical line to the right. Add a 

new column field will be seen at the extreme right corner of the table. By clicking 

on add new column, we select Work from the drop-down list.  

• Another way to add the Work column is to right-click on the column next to the 

duration column. When a drop-down menu pops up, select the Insert Column 

option from this drop-down menu. Find the Work column and click on it.   
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• After assigning Work resources to the activities, Microsoft Project calculates the 

working hours.    

 

Figure 25 Work Hours for each activity 

Project Summary Task  

• We can see the work hours required to complete the activities in each activity 

group, but we don't know the total work hours needed to complete the project. To 

view the entire works hour required to complete the project, follow the below steps.  

• Click on the File tab, select Options.  

• Click on Advanced settings  

• Scroll down and find the Display option for this project. 

• Check the show Project Summary task  

• Then Click OK 

• Now we can see our Project Summary task at row 0. We can see the total Duration 

of our Project, Start, Finish, total work hours required to complete this project.  

• We can also change the name of the project shown in the table. To do this, double 

click on the project name displayed in the summary task and a writing cursor will 

appear. Change the name of the project, we changed ours to Construction of 

Single Storey House. 

• Click enter.  
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Chapter 3 

Setting up Resources  

In the previous section, we entered the work hours for each activity and set up our 

project resources. A resource is something that is required to complete the 

task/project.  

• We can add resources by changing the Gantt Chart view to the Resource Sheet 

view.  

• To do this, click on the Gantt Chart shown at the top left corner of the Task tab. 

• We will get a drop-down list of available views. Select the Resource Sheet from 

the drop-down list. 

 

Figure 26 Open Resource Sheet 

• In the resource sheet, click on the Type button.  

• We can see three types of resources Material, Work and Cost  
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Figure 27 Resource Type 

 

A work resource is a person, a team, or a piece of machinery or equipment that 

consumes time while working on a project. Therefore, we define labor, equipment, or 

machinery resources as a work type.  

Material Resources are the resources that an activity consumes during its execution, 

like concrete, steel, etc.  

Cost is a fixed cost associated with the resources. Costs such as travel expenses or 

rental of equipment are some examples of cost resources.  

Material Resource  

In the resource sheet, click on the first row Resource Name Field and type your 

resource name, and press enter. All the remaining columns will be filled 

automatically by default.   

 

Figure 28 Change it to Materai Item Adding the Resource 

We start entering our resources from Backfilling. Since Backfilling is the material 

resource, so we change the Type from work to material. We measure backfilling 

material in Tons, and the initials of backfilling material are BCKFL. 

We will continue to do this with all resources, as shown in figure 29. Concrete is 

the material resource, so we change the Type from Work to Material. In Material, 
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we will add the units of the material. The concrete is measured in cubic meters, so 

under the material label, we write M3. In the Initials column, we entered Con as a 

concrete abbreviation.  

Similarly, we add brick as a material resource. We assume a pallet of bricks has 

1,000 bricks. The Material Label of Bricks will be in thousands, and the "000s" 

value represents thousand value. For example, we need 10,000 bricks, so; we will 

write only 10 of this resource because each pallet has 1000 bricks. In the Initials 

column, we will write BCK as the abbreviation.  

 

Figure 29 Material Resources 

Work Resource  

• Microsoft will not allow filling the Material label field because it is not a material 

resource.  

• Suppose we use an excavator for the excavation work. So, excavator is a work 

resource. We will use EXC as an initial for excavator.  

• We will state the maximum units within the Max. column. We assume only one 

excavator is required for excavation work as a resource.  

• Similarly, we add all other work resources, for example, concrete labour, mason, 

roof labour, etc.  
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Figure 30 Work Resources 

Assigning Resources  

In the last section, we determined the resources of our project. In this section, we 

will assign resources to our assumed project activities. To do this, first, we follow the 

following steps.   

• Right-click on the activities 

• Select the Assign Resource from the drop-down list. A new Assign Resources 

dialogue box will open having all the resource names.  
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Figure 31 Assigning Resources through the drop-down list  

 

Figure 32 Assigning Resources Dialogue Box 

• Or we can directly click on the Resource ribbon shown at the top. 

• When the resource tab is open, click on the Assign resources button in the ribbon's 

Assignment group, and the dialogue box will open. 

• We will use this dialogue box while assigning the resources.  

 

Figure 33 Assigning Resources through Resources ribbon 

• We want to allocate the excavator to the excavation activities. To do that, we will 

find the Excavator from the Assign Resources dialogue box.  
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• Select the Excavator and press the assign button.  

 

Figure 34 Resource Assignment Dialogue box 

• As you can see, the Excavator is assigned to the Excavation work. 

Note: We don't need to open and close the assign resources dialogue box while 

assigning resources to various activities. It will remain open until we close it.    

• Assign resources to Concrete Work  

o Assign the concrete labour shown in the assign resources dialogue box to 

‘Concreting of Floor’. We will follow the same steps for each task 

discussed earlier.  

o We assigned two concrete workers for the concreting work. So, we 

changed the unit’s value from 1 to 4. 

 

Figure 35 Assignment of Concrete Labour Resource 

• When any resource is assigned to the activity, you can notice a small tick mark 

before the Resource Name.   
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While Assigning resources, we should remember the maximum units for each Work 

Resource. We should not assign the resources more than its maximum amount 

mentioned in the resource sheet. If we exceed the maximum number of resources, the 

Red Human figure will appear before the Task Name as an indictor.  

•  We will follow the same steps while assigning the resources to the rest of the 

activities.  

Assign the Material Resource  

We have assigned work resources to our activities. Now we will allocate Material 

Resources to our Activities.  

• Right-click on the activities and select assign Resources from the drop-down list.  

• The assign resources dialogue box will open.  

• To assign concrete to concreting floor task: 

o Select Concreting of Floor from the table and select the concrete from the 

assign resources dialogue box.  

o Change the concrete units from 1M3 to 100 M3. 

 

Figure 36 Assignment of Material Resource 

• Assign Bricks for the construction of the wall. 

o Select the construction of wall activity from the table and select the Bricks 

from the Assign Resources dialogue box.   

o Change the Bricks units from 1 to 50.  

• Assign Backfilling material  
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o Select the Backfilling activity from the table and select the Backfilling 

Material from the Assign Resources dialogue Box. 

o Change the backfilling material from 1 to 1000 Tons.  

We will follow the same steps for the remaining resources.  

Costs  

We have created the Resources and assigned the resources to our project's 

activities. Now, we will learn how to assign a cost to resources.  

• Open the Resource Sheet.  

• Right-click on the Gantt Chart shown below the File Tab and select the drop-

down menu's resource sheet. 

• Let's assume one cubic meter of concrete costs us $30/M3. We will use Std. 

Rate column for entering this value. The overtime rate for all the activities is 

assumed zero.  

• Similarly, we enter costs for all the Resources. 

 

Figure 37 Costing of Resource 

Adding the Cost Resource  

Microsoft project has three types of resources, i.e., material, work, and cost. We 

have worked on material and work resources. Now, we will discuss the cost 

Resource. Some type of projects has a particular type of cost. Our project’s 

Architect fee is a cost resource, and we can use this resource as a financial cost 
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associated with a project plan task. Cost resource doesn't do any work, and they 

have no effect on the scheduling of a task.   

 

 

Chapter 4  

Assigning Baseline to a Project  

We have created our project schedule, assigned cost to resources, and then linked 

resources with the tasks. These are the preliminary requirements before effective 

monitoring of the project as well as for EVM analysis.  

Now, we assume our project is just about to start, and we will need to track the 

activities; that is, we will need to compare the actual values with our planned 

values.  

While we enter our actual values into the project schedule, the dates, durations, 

week hours, and the project's cost may be changed. If we don't reserve a copy of 

our original plan, we will not have any data for comparing values. Therefore, it is 

important to have a copy of our project schedule. We will need to copy the dates 

and the information about the resources as well as the cost of the tasks.  

A baseline provides us a copy of our project plan. It copies the schedule, the 

resources, the work hour information and the original cost information. Therefore, 

we create the baseline before starting to track our project.  

• Let's start and create the project baseline.  

• To do that, we will click on the View tab ribbon shown at the top of the screen. 

• In the Data group, click on Tables. 

• The drop-down list will pop up, select More Tables.  
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Figure 38 Assigning Baseline 

 

Figure 39 Baseline Dialogue box 

• Now we will select baseline from the dialogue box then click on the apply button. 

• The new Baseline table having baseline start, finish, work, and cost columns 

respectively will open.  

• We haven't created our baseline yet, so we don't have any value inside the fields.  

• Let's create the baseline and see what will happen.  

Create Baseline  

• To create a Baseline, click on the Project tab.  

• In the Schedule group, we will click on the Set Baseline button 



 30 

 

Figure 40 Create Baseline 

• Now you can see we can not only create the baseline but also, we can clear any 

previously created baselines. 

• To create a baseline, click on Set Baseline, and the dialogue box will open.  

• We will select Set Baseline from here. We will choose a baseline. 

• We want to create the baseline for the entire project. So, we checked it and clicked 

OK. 

Tracking the Project  

We have created our project plan. After that, we have created the Project Baseline of 

our Project. Now, we will do tracking of our project. As the project starts, we regularly 

check if everything is going okay or not. We will review the dates of the activities as 

well as the work hours and their costs. We will need to report the status of tasks and 

activities required in achieving the planned results. Tracking the project will be done 

according to the requirements of the project. For this example project, we will track 

the project weekly.  

• Let's click on the Project ribbon shown above. 

• Select the Project Information from within the properties field. 

• As before, we use this Project Information dialogue box to determine the project 

Start Date. 

• Now, we will focus on the current date and status date fields. When we track the 

project using Microsoft Project, we will enter the activities status up to the status 

date.  
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Figure 41 Current Date and Status Date 

• By default, the green line represents the current date of the project. As discussed 

earlier, Microsoft Project, by default, shows the current date line, so let's hide this 

and show the status date line.  

• Right-click on the Gantt Chart and then choose Gridlines from the drop-down 

menu.  

 

Figure 42 Show Status Line 

• In the ‘line to change’ section, select ‘current date’ before selecting the first blank 

option from the drop-down Type list under the ‘normal’ heading. It will hide the 

current date line. 
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Figure 43 Hide Current Date Line 

• Now, from the ‘line to the change’ section, select the Status Date. Then, under the 

heading ‘Normal’, click on the Type drop-down list and select the line as well as 

the Colour. 

 

Figure 44 Set Status Date Line 

• Click the OK button. Now we can see the Status Dateline.  

 

Figure 45 Showing the Status Yellow Line 
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Chapter 5 

Why EVM  

There are many various advantages associated with Earned Value Management 

(EVM) that help the higher management understand the current performance of 

the project. Using EVM, a project's future performance can be predicted by 

analyzing the EVM metrices. EVM also helps project managers to take timely 

action to avoid any risk associated with project delay or cost overrun. Some of the 

crucial attributes are given below.  

• EVM gives overall performance of the project in numerical terms. These 

numbers help the project manager to take timely action to avoid delay and 

disruption in project completion.  

• Dealing with numbers is more manageable and better than dealing with 

dates. Earned value view in Microsoft Project uses numbers rather than 

dates.  

• Project plan monitoring at any level (summary/activity) of a project is simple 

using Earned Value Analysis (EVA). 

• Customer satisfaction is improved because progress is provided to a 

customer and sponsor periodically in a status report. 

• Forecasting the effort and time required to complete the remainder of a 

project gives a clear picture of how a project is likely to end (e.g., 

with/without schedule/effort overruns). 

• Forecasting the efficiency parameters required to complete a project on 

time and under budget gives a project manager a heads-up about 

conducting team meetings. 

• Trends in effort/schedule parameters indicate to a project manager if 

serious action needs to be taken or if a subtle discussion of the situation in 

a team meeting will suffice. Managing trends in variances is another way to 

monitor a project and keep it on track. 
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• EVA is produced by plotting three performance measures (earned value, 

planned value, and actual cost). 

EVM in Microsoft Project  

EV is a robust feature in Microsoft Project that helps in project tracking and 

monitoring in terms of numbers. EVM metrices help project managers to analyze 

the current progress of the project, amount spent and how much time and money 

we need to complete the project. EVM values provide valuable insight into the 

actual situation of the project. 

Microsoft Project provides the tools to perform EVM and predict the health of the 

project. Microsoft Project enables us to measure planned and actual project 

performance and costs by using the EVM tool. In this section, we will briefly discuss 

EVM terms like PV, AC, EV, SPI that we will use in Microsoft Project.  

Before implementing the EVM, we need to complete the following steps 

Work Breakdown Structure 

WBS is an important aspect of project planning and monitoring. Ensure that you 

create a deliverable oriented WBS so that tracking is easy, and issues may be 

resolved quickly. Typically, a deliverable oriented WBS has the project at the top-

most level followed by deliverables or activities. Tasks or activities under WBS 

must be logically scheduled/linked, there are no dangling activities (all the activities 

have logical predecessor and successors) and the critical path is identifiable. The 

next step is to assign the duration to the lowest-level tasks.  

Creating Resources  

The next step in creating a schedule is setting up the resources used in Microsoft 

Project. Work, material, and cost resources for the project are created in the 

Resources tab of Microsoft Project.  

Assigning Cost to Resources 

After creating the resources, the cost is assigned to the various resources created 

in the resources sheet. After assigning the cost to resources, we will assign the 

resources to the various activities.  
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The Baseline of the Project 

When the resources are defined and assigned to tasks, we will make a baseline of 

the project. This baseline will help to compare the planned and actual/current 

progress of the project.  

Adjustments in EVM table of Microsoft Project  

As discussed earlier, we have set up our project in Microsoft Project. We will now 

adjust the EV table because it will help analyze the project performance at one glance. 

To do this, we will follow the following steps.  

• Before using this table for analysis, we must ensure that we have assigned all our 

resources and costs to our project. Secondly, we must ensure we have set our 

Project Baseline. Thirdly, we must ensure we have started our project so that we 

can add actual data to the project. 

• We will adjust our Gantt Chart view for EVM analysis.  

• In Microsoft Project, there are some tables dedicated to EVM. 

• Click on the View ribbon and select the Tables from the Data menu.  

• A drop-down list will appear; select More Tables from the drop-down list.  

                    

Figure 47 Show Earned Value Table 

• Let's select the Earned Value table.  

• There are two percentages in Microsoft Project for tracking the project. The first 

one is % complete, and the other one is physical % complete. % complete is about 

duration, whereas physical % complete tells how much physical work is done.  

 Figure 46 Earned Value Table 
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• If you are not familiar with PV, EV, and AC values, hover your cursor over the EV 

filed, and the definition of EV will appear.  

• Microsoft Project uses the percentage complete method for EVA by default. To 

change this, click File > Options > Advanced > Earned Value Options and change 

% complete to physical % complete.  

 

Figure 48 Setting Physical % Complete 

• Or there is a Shortcut of changing the % complete to Physical % complete.  

o Right-click on the PV field/column, and from the drop-down list, select insert 

new column.  

o Find Earned Value Method from the drop-down list.  

o Now Change the percentage complete to Physical Percentage complete 

and drag this down for all the activities shown in the figure.  

 

Figure 49 Setting Physical % Complete  

• After setting the physical % complete for all the activities, hide Earned Value 

Method column. 

• We added the columns of physical % complete, baseline start and finish dates, 

actual Start, and finish dates in the EV Table before starting the EVA. 
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Implementation of EVM in MP 

In this section, we will discuss two examples (a) Construction of a Wooden Chair 

and (b) Construction of a single-storey house. Both the projects are created in 

Microsoft Project (MP). In each example, we have two scenarios.  

Scenario 1: Check - Actual Cost Calculated by Project  

Scenario 2: Uncheck - Actual Cost Calculated by Project 

Example (a) - Actual Cost Calculated by Project 

Let's begin with scenario 1 when the AC is Calculated by the project. In this 

scenario, we assumed that the project is not affected by ground realities, for 

example, currency conversion rates and other adjustments that affect the AC.  

To allow Microsoft Project to calculate the AC itself, follow these steps, go to File 

➔ Options ➔ Schedule and check the box "Actual costs calculated by Project." 

 

Figure 50 Check the Actual Cost Calculated by the project 

We have assumed the Construction of a Wooden Chair as a generic project. This 

project will help us to understand the EVM in Microsoft Project better. The total 

working days for this project are 11 days and the working hours for this project are 

117 hrs. We have assumed five resources for this project. The resources are 

shown under the Resource Names column in front of each activity. Purchase of 

raw material, cutting of wood, finishing of chair, and dispatching of chair falls on 

the critical path, whereas task making of chair falls on the non-critical path. If the 

activities that fall on the critical path are delayed, then the project will be delayed.  
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Figure 51 Construction of Wooden Chair 

• Let's open the EV Table for the Generic example (View ➔ Tables ➔ More tables 

➔ Earned Value) 

 

Figure 52 Earned Value Table 

Update 1 

Current Date: 8th February 

Status Date: 7th February 

The generic project starts on 5th February and ends on 15th February. We are 

planning to update the project after every three days. In the first update, the 

project's current date is 8th February, whereas the status date is 7th February.  
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Figure 53 Project Information for Construction of Wooden Chair 1st Update 

In this example, we will add the actual start and finish dates of Purchase of raw 

material and cutting of wood activities. We will then manually add the physical % 

complete for the purchase of raw material and cutting of wood. We will then update 

the project by using the update project dialogue box, as shown in the below figure. 

After clicking the OK button, Microsoft Project calculates the % complete of 

purchase of raw material and cutting of wood.  

 

Figure 54 Update Project 

Analysis of Earned Value Table  

We can see the EV table in the below figure. We will discuss each column of the 

EV table one by one. EV table metrics help the project manager see the project's 

current performance and take corrective action if necessary for timely project 

completion. 



 40 

 

Figure 55 Earned Value table after 1st update 

Baseline / Actual Start and Finish dates  

The baseline takes a snapshot of all the project activities and helps in project 

monitoring and reporting. When we track the project, we enter the actual start and 

finish dates of the project activities. While tracking, it is important to enter each 

task’s actual data so we can compare the actual and planned performance of the 

project.  

% Complete  

Purchase of raw material: For % complete, we update the project up to the status 

date, after entering the actual start and finish dates.  Microsoft Project 

automatically calculates the % complete from the actual start and finish dates. 

Purchase of raw material under the % complete column is 100% complete. 

Cutting of wood: For % complete, we update the project up to the status date, after 

entering the actual start and finish dates. Microsoft Project calculates cutting of 

wood under the % complete column is 33% complete up to the status date.  

Physical % Complete  

Purchase of raw material: For physical % complete, we assumed that purchase of 

raw material is 100% physically complete up to the status date.  
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Cutting of wood: For physical % complete, we assumed that cutting of wood is 20% 

physically complete up to the status date. We are lagging in this activity by 13%. 

Its means that if the corrective measure is not taken, our project will be delayed.  

Planned Value 

PV refers to the total cost that should have incurred up to now, looking at the tasks 

that should have been completed by today, and valued at the original budget. You 

would say: “According to the project schedule, we should have completed THESE 

tasks. The value of these tasks in original valuation amounts to $X in planned 

value”. 

At any point in time, planned value (PV) defines the work that should have been 

accomplished. The PV is pinned with the baseline start and finish dates. 

Purchase of raw material: The actual start and finish date of purchase of raw 

material is the same as baseline start and finish dates. It means that project 

performance is on track. Purchase of raw material was two days long activity, 

having a PV equal to $10600.    

Cutting of wood: The actual start of cutting of wood is the same as the baseline 

start date. PV calculated by Microsoft Project is $400, so we can interpret from the 

given information that the cutting of wood's PV is $400/day.   

Earned Value (EV) 

Earned Value (EV) is the value of the work that has been effectively completed so 

far, using your initial cost estimations as valuation factor and not the AC. In simple 

terms: EV is the money you should have spent for the work that was actually done. 

EV has pinned with physical % complete. 

Purchase of raw material: We assume that up to the status date purchase of raw 

material is 100% complete. We entered 100% under the physical % complete 

column, and the Microsoft project will automatically calculate the EV. EV calculated 

by the Microsoft project is $10600 up to the status date.  
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Cutting of wood: We assume that cutting of Wood B is 20% complete up to the 

status date. We entered 20% under the physical % complete column, and the 

Microsoft project will automatically calculate the EV. The Microsoft Project's EV is 

$240 ($1200*.20) up to the Status Date. The physical % complete is 13% less than 

the planned EV, which means we are lagging behind the physical progress, and 

the project can be delayed.  

Actual Cost (AC)  

The amount of costs effectively incurred up until now. 

Purchase of Raw Material: We assumed that the project is on track in terms of time 

and cost, so the AC computed by Microsoft project is $10600.  

Cutting of wood: We assumed that the project is on track in terms of time and cost 

up to the status date, so the AC computed by Microsoft project is $400.  

Schedule Variance (SV) 

How far ahead or behind is the project? The SV is calculated as the difference 

between Earned Value and Planned Value, meaning SV = EV – PV. SV keeps 

your project on schedule and helps us to complete our project on time. SV lets us 

know if we are ahead of schedule or behind schedule in dollar terms. 

Purchase of raw material: Schedule variance for the purchase of raw material is $0. 

$0 represents that planned cost and EV are the same up to the status date so, the 

difference is zero dollars. 

Cutting of wood: Schedule variance for the cutting of wood is -$160. -$160 is the 

difference between the planned cost ($400) and EV ($240) up to the status date. 

The negative sign represents that we are behind schedule in terms of dollars.  

Cost Variance (CV) 

Looking at the project right now, how far under or over budget is it? The Cost 

variance is calculated as CV = EV – AC. CV is a measure of a project's cost 

performance and deals with the project's cost baseline. CV gives information on 

whether we are over or under budget, in dollar terms.  
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Purchase of raw material: Cost variance for the purchase of raw material is $0. $0 

represents that AC and EV are the same up to the status date so, the difference is 

zero dollars. It means we are under budget.  

Cutting of wood: Schedule variance for the cutting of wood is -$160. -$160 is the 

difference between the AC ($400) and EV ($240) up to the status date. It means 

we are over budget.  

Estimate at Completion (EAC) 

The amount of money necessary to complete the budget, factoring in money you 

have spent un until now. In other words: How much money is required to complete 

the project. These metrics help us to understand whether we can complete our 

project within the approved budget or not.  

Purchase of raw material: EAC for the purchase of raw material is 

$10600. Microsoft project uses this formula for the computation of 

EAC.  

(ACWP + (Baseline Cost X– BCWP)) / (EV/AC)  

= (10600+(10600-10600))/ (10600/10600)  

= $10600.  

Cutting of wood: EAC for the cutting of wood is $2000. We will use the same 

formula as mentioned above for the EAC calculation. By looking at the EAC 

metrics, we can say that we are over budget. We need an additional budget to 

compete for this activity.  

Baseline Cost (BAC)  

This cost field is generated when we save the baseline or the total approved 

budget. It shows how much budget is required to complete this activity.  

Purchase of raw material: BAC for the purchase of raw material is $10600. 

Cutting of wood: BAC for the cutting of wood is $1200.  

Baseline Cost X  

It means consider 

the Baseline Cost up 

to the Status Date. 
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Variance at Completion (VAC)  

The predicted final cost variance (CV), assuming the project continues with the 

same pace and quality it has shown so far. VAC is a projection of the budget 

surplus or deficit. It is expressed as the difference between the BAC to the EAC. If 

the VAC is a positive integer, it means that the project is under budget. If the result 

is negative, then it means that the project will be over budget.   

Purchase of raw material: VAC for the purchase of raw material is $0. It shows we 

are under budget. 

Cutting of wood: VAC for the cutting of #wood is -$800. It means we are over 

budget we need additional resources to complete the task.  

Schedule Performance Index (SPI) 

How far ahead or behind schedule is the project, expressed as a ratio of the overall 

project duration. Formula: SPI = EV / PV. An SPI of less than 1 indicates your 

project is behind schedule, whereas a value greater than 1 means you are ahead 

of schedule. 

Purchase of raw material: SPI for the purchase of raw material is 1. It shows that 

the project is on track.  

Cutting of wood: SPI for the cutting of wood is 0.6. It means that we are lagging 

behind the planned schedule performance.  

Cost Performance Index (CPI) 

How far above or below schedule the project is in comparison with the total 

approved project budget. CPI = EV / AC.  

Purchase of raw material: CPI for the purchase of raw material is 1. It shows that 

the project is under budget.  

Cutting of wood: CPI for the cutting of wood is 0.6. It means that the project is over 

budget.  
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Earned Value Graph for 1st update 

In this section, we will look toward the graphical representation of our project. To see 

the visual presentation of EV, PV and AC follow the following steps. 

• Click on Reports, shown at the top  

• Select the Visual Reports from the Reports group 

• Select the Earned Value Over Time Report 

• Click View, an excel file will open. In the excel file, we can see the Earned Value 

Over Time graph 

 

Figure 56 Earned Value Over Time 

From the first update, we can see the following graph of EV. According to this graph, 

our EV is less than PV and AC. It means we are lagging behind schedule as well as the 

cost. PV is equal to AC in the 1st update; that is why we cannot see the PV.  
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Figure 57 Earned Value Over Time Graph 

Update 2 

Current Date: 11th February  

Status Date: 10th February 

The ‘Construction of a Wooden Chair’ project was updated until 7th February. In 

the second update, the project's current date was 11th February, whereas the 

status date was 10th February.  

 

Figure 58 Project Information for Construction of Wood Chair 2nd Update 

We will now add the actual start and finish dates of cutting of wood, making of 

chair, and finishing of chair activities. After entering the actual dates for cutting of 

wood, making of chair, and finishing of chair, we will manually add the physical % 
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complete for cutting of wood, making of chair, and finishing of chair. We will then 

update the project by using the update project dialogue box, as shown in the below 

figure. After clicking the OK button, Microsoft Project calculates the % complete of 

cutting of wood, making of chair, and finishing of chair activities. After entering all 

of the data up to status date, we will update the project up to the status date.  

 

Figure 59 Earned Value Table from 2nd Update 

2nd Update - SPI and CPI  

We can see that the SPI and CPI value for making of chair is 0.4. It means that the 

making of chair actvity is behind scheduled performance and over budget.  

Whereas the finishing of chair, SPI, and CPI value is 0.99. It is nearly equal to 1, 

which means the finishing of chair activity performance is on track and under 

budget.  

Update 3 

Current Date: 12th February  

Status Date: 11th February 

The ‘Construction of Wooden Chair’ project was updated until 10th February. In the 

third update, the project's current date is 12th February, whereas the status date is 

11th February.  
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Figure 60 Project Information for Construction of Wooden Chair for 3rd update 

We will now add the actual start and finish dates of the making of the chair and 

finishing of chair activities. It was planned to complete the finishing chair activity 

on February 11th, but due to the finishing material not being available, the activity 

is delayed for one day and will restart on February 11th. After entering the actual 

dates for the making of chair activity, we will manually add it’s physical % complete. 

Then, we will update the project up to the status date. 

So due to this delay event, we will check the "Reschedule uncompleted work to 

start after 11 Feb" rather than selecting "Update work as complete through:" Click 

the OK button to update the schedule.  

 

Figure 61 Reschedule the uncompleted work 

After clicking the OK button, we can see the split in the Gantt chart during finishing 

chair work. The split in the Gantt chart shows the non-working period.  
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Figure 62 Earned Value Table from 3rd Update 

3rd Update - SPI and CPI  

We can see that the SPI and CPI value for the making of chair activity is 1. This 

means that the activity’s performance is on track and is under budget.  

Whereas the task finishing of chair has an SPI and CPI value is 0.49 and 0.99, 

respectively. This SPI value indicates that the project is behind schedule, and the 

CPI value suggests the task is performing under budget. The same result can be 

seen in the earned value overtime report graphs.  

 

Figure 63 Earned Value Over Time Graph 
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Example (a) – Uncheck Actual Cost Calculated by Project  

Let's begin with scenario 2, when we uncheck the actual cost calculated by the 

project. In this scenario, we assumed that the project is affected by ground 

realities, for example, currency conversion rates and other adjustments that affect 

the AC.  

To stop Microsoft Project from calculating the AC itself, follow these steps: Select 

File ➔ Options ➔ Schedule and uncheck the box "Actual costs are always 

calculated by Project." 

 

Figure 64 Uncheck Actual Cost Calculated by Project 

By unchecking this box it means we will now have to manually enter the cost 

incurred during the project's execution. So, in our first update, the project progress 

remains the same as mentioned above. In other words, we are not changing the 

actual project cost in the first update.  

We have assumed the construction of a wooden chair as a generic project. This 

project will help us to understand the EVM in Microsoft Project better. The total 

working days for this project are 11 days and the working hours for this project are 

117 hrs. We have assumed five resources for this project. The resources are 

shown under the column ‘Resource Names’ within the corresponding task name’s 

row. The tasks purchase of raw material, cutting of wood, finishing of chair, and 

dispatching of chair fall within the critical path, whereas the making of chair activity 

falls on the non-critical path.  
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Figure 65 Construction of Wooden Chair 

• Let's open the Earned Value Table for the generic example (View ➔ Tables ➔ 

More tables ➔ Earned Value) 

 

Figure 66 Earned Value Table 

Update 1 

Current Date: 8th February 

Status Date: 7th February 

The generic project starts on 5th February and ends on 15th February. We are 

planning to update the project after every three days. In the first update, the 

project's current date will be 8th February, whereas the status date will be 7th 

February.  
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Figure 67 Project Information for Construction of Wooden Chair 1st Update 

In this example, we will show three steps used to update.  

• Entering the actual start and finish dates of the activities purchase of raw 

material and cutting of wood. 

• Enter the AC manually.  

• Update Project  

In this example, we will add the actual start and finish dates of purchase of raw 

material and cutting of wood activities. We will then manually add the physical % 

complete for the purchase of raw material and cutting of wood tasks. We will now 

update the project using the Update Project dialogue box, as shown in figure 71. 

After clicking the OK button, Microsoft Project calculates the % complete of tasks 

purchase of raw material and cutting of wood. After entering the data, we can see 

the EV and PV values, but the AC column will remain empty. This is because we 

have decided to fill the AC column manually up to the status date. 
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Figure 68 Entering Actual Data for 1st update 

To manually enter the AC, we will click on the View tab shown at the top of the screen.  

• Select ‘Tables’ from the data group.  

• Select ‘More Tables’ from the drop-down list.  

• Select the ‘Earned value Cost Indicators’ from the dialogue box, as shown in 

figure 69. 

 

Figure 69 More Tables for Entering Actual Cost 

In figure 70, we have entered the AC incurred during the execution of the project. 
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Figure 70 Entering Actual Cost for 1st update 

After completing the steps mentioned above, we will update the project up to the 

status date. To update the task, we will click on the update status button, and then 

a dialogue box will appear. Then, we will click on the OK button.  

 

Figure 71 Update Project 

After clicking OK, the Earned Value table will be updated up to the status date.  

 

Figure 72 Earned Value Table from 1st update 

Analysis of Earned Value Table  

We can see the EV table in the above figure. We will discuss each column of the 

EV table one by one. EV table matrices help the project manager see the project's 

current performance and take corrective action if necessary for timely completion 
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of the project. The result of this EV table is the same as discussed earlier in 

scenario 1.  

1st Update - SPI and CPI  

‘Purchase of Raw Material’: SPI and CPI for this task are 1. It shows that the project 

is on track and under budget.   

‘Cutting of Wood’: SPI and CPI for this task are 0.6. This means that we are lagging 

behind the planned schedule performance and are over budget.  

Update 2 

Current Date: 11th February  

Status Date: 10th February 

The ‘Construction of a Wooden Chair’ project was updated until 7th February. In 

the second update, the project's current date is 11th February, whereas it’s status 

date will be 10th February.  

 

Figure 73 Project Information for Construction of Wooden Chair 2nd 

Update 

Again, we will follow these three steps to update Project:  

• Entering the actual start and finish dates of the purchasing of raw materials 

and cutting of wood tasks. 

• Enter the AC manually.  

• Update Project. 
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We will now add the actual start and finish dates of the tasks cutting of wood, 

making of chair, and finishing of chair. After entering the actual dates for these 

tasks, we will manually add the physical % complete for each. We will then update 

Project using the ‘Update Project’ dialogue box. After clicking the OK button, 

Microsoft Project calculates the % complete of each task.  After entering all of the 

data up to status date, we will update Project up to the status date.   

 

Figure 74 Entering Data for 2nd update 

In figure 75, we have entered the AC incurred during the execution of the project. 

 

Figure 75 Entering Actual Cost for 2nd update 

After completing the steps mentioned above, we will update the project up to the 

status date, and EV table will be updated up to the status date.  
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Figure 76 Earned Value table from 2nd Update 

2nd Update - SPI and CPI  

We can see that the SPI and CPI value for Making of Chair is 0.4. This means that 

the ‘Making of Chair’ task is lagging in schedule performance and is over budget.  

Whereas the ‘Finishing of Chair’ tasks SPI and CPI value is 0.99. It is nearly equal 

to 1, which means the task performance is on track and under budget.  

Update 3 

Current Date: 12th February  

Status Date: 11th February 

The ‘Construction of a Wooden Chair’ project was updated until 10th February. In 

the third update, the project's current date will be 12th February, whereas the status 

date will be 11th February.  
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Figure 77 Project Information for Construction of Wooden Chair for 3rd update 

We will add the actual start and finish dates of making the chair and finishing the 

chair. The finishing chair task is delayed due to the lack of available finishing 

material. The finishing activity is delayed for one day and will restart on 11th 

February. After entering the actual dates for the making the chair task, we will 

manually add the physical % complete for the task.  

We will add the AC incurred for the making of the chair and finishing of the chair 

activities. The AC incurred for the making of the chair is $1000 which is $200 higher 

than the planned AC of this activity. The AC incurred up to the status date for the 

finishing of the chair is $300 which is also $200 higher than the planned AC of the 

finishing of the chair activity. The increase in cost is due to the delay in receiving 

materials which caused a delayed task start date.  

 

Figure 78 Entering Cost for 3rd update 

Now we update Project up to the status date. So due to this delay event, we will 

check the "Reschedule uncompleted work to start after 11th Feb" instead of using 
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"Update the work completed through." Click the OK button to update the schedule 

up to the status date.  

 

Figure 79 Reschedule the Uncompleted Work 

After clicking the OK button, we can see the split in the Gantt chart for the activity 

‘finishing of chair’ as shown in figure 81. The split in the Gantt chart shows the non-

working period.   

Analysis of Earned Value Table  

We can see the EV table in the below figure. We will discuss each column of the 

EV table one by one.  

 

Figure 80 Earned Value table after 3rd update 

Baseline / Actual Start and Finish dates  

Baseline/Actual Start: Making of Chair Baseline and Actual Start remains the 

same.  

Baseline/Actual Finish: Making of Chair Baseline and Actual finish remains the 

same.  

Baseline/Actual Start: Finishing of Chair Baseline and Actual Start remains the 

same.  
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Baseline/Actual Finish: Finishing of Chair Baseline and Actual is changed due to 

non-availability of the material. So, the Finishing of the Chair is delayed by a day.  

% Complete  

Making of Chair: For % complete, we update the project up to the status date, after 

entering the actual start and finish dates.  Microsoft Project automatically 

calculates the % complete from the actual start and finish dates. The task making 

of chair under the ‘% complete’ column is 100% complete. 

Finishing of Chair: For % complete, we update the project up to the status date 

without entering the actual finish date because the activity is delayed for one day. 

We can see a gap in the Gantt chart for the finishing chair task which represents 

the non-working period. Microsoft Project calculates the task’s % complete under 

the ‘% complete’ column which remained 33% complete up to the status ate.  

 

Physical % Complete  

Making of Chair: For physical % complete, we assumed the task is 100% physically 

complete up to the status date.  

Finishing of Chair: For physical % complete, we assumed the task is 33% 

physically complete up to the status date. We are lagging behind in this activity by 

13%. This means that if the corrective measure is not taken, our project will be 

delayed.  

Planned Value 

Making of Chair: The actual start and finish date of the task are the same as 

Baseline start and finish dates. The PV for the activity up to the status date is $800.     

Finishing of Chair: The actual start of the task is the same as Baseline start, 

however the actual finish date is not the same as the Baseline finish date. PV 

calculated by Microsoft Project is $200, up to the status date.  
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Earned Value (EV) 

Making of Chair: We assume that up to the status date, this task is 100% complete. 

We entered 100% under the ‘physical % complete’ column. EV calculated by the 

Microsoft Project is $800 up to the status date.  

Finishing of Chair: This task is 33% complete up to the status date. We entered 

33% under the ‘physical % complete’ column. The Microsoft Project's EV is $99 

($300*.33) up to the status date. The physical % complete is 33% less than the 

planned EV because of a delay (33% for each day). It means we are lagging behind 

the physical progress, and the project can be delayed.  

Actual Cost (ACWP)  

Making of Chair: We assumed that the activity is on track in terms of time. The AC 

incurred for the task is $1000. An increase of $200 in AC is due to the delayed 

event.  

Finishing of Chair: We assumed that the activity is delayed for one day. So, the 

activity cost is increased up to the status date. AC incurred for the task is $300. An 

increase in AC is because of the delayed event.  

Schedule Variance (SV) 

Making of Chair: Schedule variance for this task is $0. $0 represents that planned 

cost and EV are the same up to the status date so, the difference is zero dollars. 

Finishing of Chair: Schedule variance for this task is -$101. -$101 is the difference 

between the planned cost ($200) and EV ($99) up to the status date. The negative 

sign represents that we are behind schedule in terms of dollars.  

Cost Variance (CV) 

Making of Chair: Cost variance for this task is -$200. -$200 represents that AC and 

EV are not the same up to the status date. It means we are over budget because 

of the delayed event.  
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Finishing of Chair: Cost variance for this task is -$201. -$201 is the difference 

between the AC ($300) and EV ($99) up to the status date. It means we are over 

budget.  

Estimate at Completion (EAC) 

Making of Chair: EAC for this task is $1000. It means we require $200 in additional 

funds to complete this activity. 

Finishing of Chair: EAC for this task is $909. By looking at the EAC metrics, we can 

say that we are over budget. We require an additional budget of $609 to complete 

this activity.  

Baseline Cost (BAC)  

This cost field is generated when we save the baseline. This shows how much 

budget is required in order to complete the activity.  

Making of Chair: BAC for this activity is $800. 

Finishing of Chair: BAC for this activity is $300.  

Variance at Completion (VAC)  

Making of Chair: VAC for this activity is -$200. It shows that we are over budget. 

Finishing of Chair: VAC for this activity is -$609. This means we are over budget 

and we need additional funds/resources in order to complete the task.  

Schedule Performance Index (SPI) 

Making of Chair: SPI for this task is 1. This shows that the project is on track.  

Finishing of Chair: SPI for this task is 0.49. This means that we are lagging behind 

the planned schedule performance.  

Cost Performance Index (CPI) 

Making of Chair: CPI for this task is 0.8. It shows that the project is over budget.  

Finishing of Chair: CPI for this task is 0.33. It means that the project is significantly 

over budget.  
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Earned Value Graph for 3rd update 

In this section, we will look toward the graphical representation of our project to 

see the visual presentation of EV, PV and AC. 

From the first update, we can see the following graph of EV. According to this 

graph, our AC>PV> EV. It means the AC of the project is high in comparison to the 

planned cost. Secondly, we can see we are lagging behind the schedule 

performance as EV is less than PV.  

 

Figure 81 Earned Value Over Time Graph 3rd Update 

We completed both the scenarios for the ‘Construction of Wooden Chair’ project. 

In each scenario, we analysed the EVM matrices. These matrices help us to 

analyse the performance of the project up to the status date.  

Now we will discuss our second example that is the construction of a single storey 

house. This example is also created in Microsoft Project. In each instance, we have 

two scenarios.  

Scenario 1: Check - Actual Cost Calculated by Project  

Scenario 2: Uncheck - Actual Cost Calculated by Project 
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Example (b) - Actual Cost Calculated by Project 

Let's begin with scenario 1 when the actual cost is calculated by Project. In this 

scenario, we assumed that the project is not affected by ground realities, for 

example, currency conversion rates and other adjustments that affect the AC.  

To allow Microsoft Project to calculate the AC itself, following these steps, Go to 

File ➔ Options ➔ Schedule and check the box "Actual costs are always calculated 

by Project". 

 

Figure 82 Check the Actual Cost Calculated by the project 

We have assumed the construction of a single storey house. All the project detail 

related to the construction of the single storey house is discussed in detail in the 

previous chapters. In this section, we will conduct the EVM analysis.  

Update 1 

Current Date: 8th February 

Status Date: 7th February 

The construction of a single storey house on 1st February and will be complete on 

10th March. In the first update, the project's current date is 8th February, whereas 

the status date is 7th February.  
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Figure 83 Project Information for Construction of Single Storey House 1st Update 

In this example, we will add the actual start and finish dates of the following project tasks: 

received approved drawings from the architect, start the excavation work, laying of lean, 

and construction of the foundation activities. We will then manually input the physical % 

complete for the same activities. At this point, we will update the project using the ‘Update 

Project’ dialogue box, as shown in the below figure. After clicking the OK button, Microsoft 

Project calculates the % complete of the above-stated activities. 

 

Figure 84 Update Project 

Analysis of Earned Value Table  

We can see the EV table in the below figure. EV table matrices help the project 

manager know the project's current performance and take corrective action if 

necessary to complete the project in a timely manner. 
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Figure 85 Earned Value table after 1st Update  

1st Update - SPI and CPI 

We can see that the SPI and CPI value for the tasks, received approved drawings 

from the architect, start of excavation work, laying of lean, and construction of 

foundation, is 1. It means that the stated activities are not lagging behind the time 

and budget.  

 

Update 2 

Current Date: 21st February  

Status Date: 20th February 

The ‘Construction of Single Storey House’ project was updated until 7th February. 

In the second update, the project's current date is 21st February, whereas the 

status date is 20th February.  
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Figure 86 Project Information for Construction of Single Storey House 2nd Update 

We will now add the actual start and finish dates of the task’s construction of walls 

above the foundation level and concreting of the floor. The fixing of the 

prefabricated roof is delayed, so; we did not enter the actual finish date of this 

activity. After entering the actual dates for construction of walls above the 

foundation level, concreting of the floor, and fixing of the prefabricated roof, we 

manually add the physical % complete for these tasks. We will then update the 

project by checking the "Reschedule uncompleted work to start after 20th Feb" 

option. After the update, Microsoft Project calculates the % complete for the tasks. 

 

Figure 87 ‘Reschedule uncompleted work to start after’ Option. 

Analysis of Earned Value Table  

We can see the EV table in the below figure. EV table matrices help the project 

manager know the project's current performance and take corrective action if 

necessary to complete the project in a timely manner. 
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Figure 88 EVM results after the 2nd update 

2nd Update - SPI and CPI 

Construction of walls above the foundation level, concreting of the floor: SPI and 

CPI Value for stated tasks are 1. This means that the activities are not lagging 

behind the time and budget.  

Fixing of the prefabricated roof: SPI and CPI Value for this task are 1. It means 

that the activity is lagging behind the time and budget.  

Earned Value Graph for 3rd update 

In this section, we will look toward the graphical representation of our project to 

see the visual presentation of EV, PV and AC. 

From the first update, we can see the following graph of EV. According to this 

graph, our PV>AC>EV. It means the PV of the project is high in comparison to EV 

and AC. Secondly, we can see we are lagging behind the schedule performance 

as the EV is less than PV.  
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Figure 89 Earned Value Over Time Graph 2nd Update 
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